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1 Introduction

Excalibur is a Macintosh spelling checker for plain text documents. It will spell check
documents created by any text editor such as BBEdit, Alpha, Emacs or MPW. It will
also spell check the clipboard, making it a useful spelling checker for mail programs
such as Eudora and news readers such as NewsWatcher.

Excalibur is also a very good LATEX spelling checker. LATEX is a collection of type-
setting macros. If you’re not a LATEX user, you should turn off the option that makes
Excalibur aware of LATEX. See LATEX Options (section 7.10 on page 10) for more
information.

Excalibur is a stand-alone spelling checker that you can use with many other appli-
cations. If you want to use it for spell checking the clipboard, it’s probably best to turn
on the Open the Clipboard option or the Open the Clipboard and Go option. See
Start-up Actions (section 7.9 on page 10) for more information.

Excalibur supports Word Services which streamlines its operation with MT-
NewsWatcher, Eudora Pro, Communicate, Nisus Writer, and ClarisWorks.

2 Excalibur’s LATEX Philosophy

One approach to LATEX spell checking is to put all the commands into the dictionary.
This yields limited success because it does not specify what should be done with the
arguments of the commands. For example, the \label command has an argument
that should always be ignored. On the other hand, the \section command has an
argument that should always be spell checked. To complicate things more, there are
commands such as \addtocontents that have one argument that should be ignored,
and another that should be spell checked.

Excalibur does not put LATEX commands into its dictionary. Instead, it knows how
to process each command intelligently. It knows which arguments to ignore and which
it should spell check. As a result, Excalibur is a LATEX spelling checker that does a very
good job.

3 Installing Excalibur

We have packaged Excalibur so that it is ready to go. Excalibur will know about any
dictionaries that it finds in its folder. If you would like to keep your dictionaries on a
server, put aliases to them in the Excalibur folder. Then, Excalibur will be able to
insert them into its Dictionary menu when it starts up.

If you use dictionaries other than the Standard Dictionary, adjust Excalibur’s mem-
ory partition. System 8 is a bit more picky about having the memory partition set prop-
erly than System 7. See Large Documents and Dictionaries (section 9 on page 11)
for more information.
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4 Uninstalling Excalibur

To uninstall Excalibur, just throw the Excalibur folder in the trash. You should also
remove the file Excalibur Preferences in the Preferences folder. There are no other
files to remove.

5 Excalibur Features

• Excalibur recognizes LATEX, AMS-LATEX, and epic commands. It also recog-
nizes a fair number of plain TEX commands.

• You can teach Excalibur about new commands and environments that you define.

• Excalibur knows about accented characters and ligatures. This should help non
English speaking users. They can add words with accents and ligatures to their
dictionaries.

• Excalibur knows about discretionary hyphens.

• Excalibur will optionally ignore text in the \tt font. This is very useful for peo-
ple (like us) who are in computer science and often sprinkle their documents with
file names in the typewriter font.

• Excalibur ignores everything that appears in the following environments:

alltt equation
cprog math
displaymath subeqnarray
eqnarray verbatim
eqnarray* verbatim*

Excalibur ignores the following AMS-LATEX environments:

align gather*
align* multline
alignat multline*
alignat* xalignat
comment xalignat*
equation* xxalignat
gather xxalignat*

It also ignores everything that appears within

– \[. . .\], \(. . .\),$. . .$, $$. . .$$ and \begintt. . .\endtt.

• Excalibur ignores the arguments of \verb and \verb* commands.

• Excalibur is 32-bit clean and System 7 friendly.

• Excalibur will warn you if it thinks it found a LATEX syntax error in a file. This
usually means that you have unmatched braces, unmatched \begin . . .\end
pairs, or an unmatched math mode delimiter.
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• Excalibur will spell check the contents of the clipboard. You can copy text to
the clipboard, have Excalibur check it, and then write the results back onto the
clipboard. With this feature you can use Excalibur as a spelling checker for pro-
grams such as Eudora.

6 Program Components

6.1 The File Menu

Most of the items in the File menu are standard for a Macintosh application. This menu
contains items to open a file, close a file, save the changes to a file, reverting a file,
and quitting the program. If you have started to spell check a file and you suddenly
remember that you forgot to activate a dictionary, you can use Revert to put the spell
checking operation in its initial state. Then, activate your dictionary and hit Start.

The Open Clipboard item will let you open the clipboard for spell checking. When
spell checking the clipboard, the Save item becomes Save Clipboard so you can save
your changes back to the clipboard. This is useful if you want to spell check just a small
portion of a document. You can copy the text to the clipboard, check its spelling, save
the result back to the clipboard, and then paste the result back into your document.

6.2 The Dictionary Menu

The Dictionary menu lets you create new dictionaries and add words to existing dictio-
naries. It also lets you select the dictionaries that you would like to use for spell check-
ing.

6.2.1 Create Dictionary

Excalibur comes with a Standard Dictionary of about 47,000 English words. If you
would like to create your own dictionary so you can add words that aren’t in the Standard
Dictionary, use the Create Dictionary item in the Dictionary menu. You can save the
dictionary any place you like, but Excalibur looks first in its own folder for dictionaries.
If it doesn’t find any dictionaries there, you will have to tell it where to find them. It’s
probably easiest to save your dictionaries in the Excalibur folder.

6.2.2 Save Dictionaries

The Save Dictionaries menu item will save any dictionaries that have changed since
you started Excalibur. If you forget to invoke the Save Dictionaries command, Ex-
calibur will warn you when you try to quit.

6.2.3 Add Word...

You can use this to add a word to a dictionary when you are not spell checking a docu-
ment. You must have a user defined active dictionary for this item to be enabled. See
Active Dictionaries (section 6.4 page 6) for more information on active dictionaries.
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This dialog will let you add a word if it is not already present in another dictionary. If
the word is already present, Excalibur quietly does nothing when you hit the Add but-
ton. If you would like to add a word to a selected dictionary even if it is already present
in another dictionary, hold down the option key when you click on the Add button.

6.2.4 Conversions

Using the Conversions menu you can convert a dictionary to a text file so you can edit
it. This is useful if you want to remove or add words. You can also convert a text file
to a dictionary. The words do not have to be sorted.

When you convert a dictionary to a text file, Excalibur gives you the option of set-
ting the file creator for the resulting text file. You can choose MS Word, Alpha, or a
generic text file.

Excalibur is capable of keeping track of up to 7 dictionaries at a time. If you have
7 dictionaries in the Dictionary menu and you try to convert a dictionary that is not
already there, Excalibur will display an error saying that the dictionary list is full. You
can correct the problem by quitting Excalibur and removing at least one dictionary from
the Excalibur folder.

When you convert a text file to a dictionary, Excalibur gives you the option of sav-
ing the file as read only. If you choose this option, you will not be able to add words to
the dictionary from within Excalibur. It’s a good idea to keep the Standard Dictionary
read only.

Excalibur will recognize accents and ligatures if the Do LATEX Command Pars-
ing option is checked. If you don’t have any accents or ligatures, you can uncheck this
option and the conversion will be a little faster.

Excalibur also looks at the Word Boundaries options when doing a text to dictio-
nary conversion. So, if you have Regard ’s as end of word selected, Excalibur will
not add any words ending in ’s to your dictionary.

If you want to add a few words to a larger dictionary, first convert the larger dictio-
nary to a text file. Then, copy the words you want to add onto the end of the file. Finally,
convert the file back into a dictionary. We expect that this will be the most common use
of conversions, so we have tuned the text to dictionary conversion so that it performs
best under these circumstances. If you have a completely unsorted list of words that you
would like to convert to a dictionary, the conversion may be lengthy. Sorting the words
first will speed things up greatly. Convert your word list to lower case before doing the
sort.

If you are using System 7 or higher Excalibur will use temporary memory (if neces-
sary) when doing conversions. If your machine has a lot of free memory, it will grab as
much as it needs to complete the conversion. It releases this memory when it is finished.

If you are using System 6, you may have to increase Excalibur’s memory partition
to convert a large file. See Large Documents and Dictionaries (section 9 on page 11)
for information on how to do this.

You can use Excalibur’s conversions to produce a sorted list of words that appear
in a document. First, perform a text to dictionary conversion using a text document as
input. Then, convert your new dictionary to a text document. The result will be a sorted
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list of all the words that appear in your document. Since the words in the original file
are unsorted, this operation can be slow if the original document is large.

Technical Note: Text to dictionary conversions can be very slow if the text file is not
sorted. Excalibur is in the sort phase when the progress indicator is between 50% and
75%. If you sorted your text file before initiating a text to dictionary conversion, and
Excalibur is still very slow when the progress indicator is in this area, you may need
to change the way you do the sort.

First, be sure that all the words are in lower case letters before doing the sort. This
will have an effect on the sort.

Second, not all machines treat the characters in Apple’s extended character set in the
same way. If you sort your file on a Unix workstation, check to see where the words that
begin with an accented character appear. If these words appear at the end of the file after
a sort, then everything is fine. If they all appear at the top of the file, then there’s a prob-
lem. Your machine is treating these characters as signed characters. Since they have
their high order bit set, they have the smallest keys. This is not the same ordering that
the Macintosh uses. See if your sort routine has a switch that lets you treat all characters
as unsigned. If you’re desperate, send some mail to zaccone@bucknell.edu. I’ve
put together a quick and dirty sort routine that works properly on a Unix workstation.
You will need an ANSI C compiler to compile it. (I use gcc.) A sorted file should take
at most several minutes to convert to a dictionary. An unsorted file may take several
hours.

6.2.5 The Dictionary List

The bottom portion of the Dictionary menu contains a list of your dictionaries. Excal-
ibur uses the checked dictionaries in its spell checking operation. You can check and
uncheck dictionaries before you begin the spell check operation. Once you have begun,
you can’t change them. You can change dictionaries between spell checking operations.
Any dictionary that is checked is an active dictionary. See section 6.4 on page 6 for
more information on active dictionaries.

If a dictionary name appears in plain text, it is modifiable. That is, you can add
words to it. If the name appears in italics, the dictionary is read only.

6.3 Definitions Menu

You can teach Excalibur about new LATEX commands and environments that you have
defined with the Definitions menu.

If you define a new command with either \newcommand or \renewcommand,
you can tell Excalibur about it by selecting the Edit Commands... item. Enter the
name of your command in the text box, select the number of arguments with the pop-
up menu, and hit the Add button. You can add any number of commands to the list.
Each command in the list is followed by the number of arguments that Excalibur should
ignore. Thus, if you define a command that has three arguments and you would like
Excalibur to spell check the third argument, tell Excalibur to ignore two arguments.
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You can tell Excalibur about new environments in a similar fashion. Use the Edit
Environments.. . menu item. It performs exactly the same as the Edit Commands...
item.

You cannot specify the number of arguments for an environment since Excalibur
doesn’t need to know this number. If you add an environment called foo, Excalibur
will ignore everything between \begin{foo} and \end{foo}. Thus, the number
of arguments is irrelevant.

Use the Save Definitions.. . command to save the commands and environments that
you have defined to a file. You can read a file that contains command and environment
definitions with the Read Definitions.. . command.

The Clear Definitions command will cause Excalibur to forget about the currently
defined definitions.

Excalibur will check the list of user defined commands and environments before
checking to see if a command or environment is part of standard LATEX. Thus, if you
change the definition of a standard LATEXcommand with

\renewcommand

Excalibur will not get confused.

6.4 Active Dictionaries

Throughout this manual, we will refer to any dictionary that is checked in the Dictio-
nary menu as an active dictionary. You can add or remove a check mark by selecting
that menu item. Excalibur uses the active dictionaries when spell checking.

Note: In order for the Add... button to be operational, you must have at least one
modifiable dictionary that is active. A dictionary is not modifiable if its name appears
in italics in the Dictionary menu. A dictionary is active if it is checked.

6.5 The Document Window

The top portion of Excalibur’s display is the document window. Excalibur will show
you the context for your misspelled words here.

6.6 The Control Dialog

Most of your interaction with Excalibur will be through the control dialog. It contains
buttons for starting the spell check operation and for making corrections to words. You
must open a document using Open... in the File menu for the control dialog to appear.

6.7 The Help Menu

You can use the Help menu to get access to the complete Excalibur manual and the
Excalibur home page. Excalibur will use the browser specified by Internet Config to
open these URLs. If you do not have Internet Config installed on your machine, these
menu items will not be available.
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Internet Config is free and very useful. If you don’t have it installed, you should
consider it. It is available from most Macintosh archive sites and from the author:

http://www.quinn.echidna.id.au/Quinn/Config/

7 Program Operation

7.1 Getting Started

To begin spell checking, hit the Start button.
Excalibur will display incorrect words in the Unknown Word field. This means

that it wasn’t able to find the word in any active dictionary. See Active Dictionaries
(section 6.4 on page 6) for more information on active dictionaries.

7.2 How To Make a Spelling Correction

You enter spelling corrections through the Change To: box. You can get text into this
box in several ways.

1. Simply enter the correct word.

2. Hit the Change button. This will copy the incorrect word to the Change To: box.
You can then edit the word.

3. Double click on the misspelled word in the document. This will copy the incor-
rect word to the Change To: box. You can then edit the word.

4. Ask Excalibur to suggest a correction by hitting the Suggest button. If you see
the correct spelling in the list of words that Excalibur presents, double click on
it. This will copy the correct word into the Change To: box.

To complete the change operation, hit the Change button.
Helpful hint: If the Change To: box is empty, then Excalibur uses the flagged

word to create its suggestion list. If the Change To: box has text in it, Excalibur uses
that text as a basis for its suggestion list. So, if Excalibur doesn’t give you a suggestion
that you like, hit the Change button to copy the flagged word into the Change To: box.
Then change its spelling slightly and hit Suggest again.

7.3 Ignoring a Word

If you would like to ignore what Excalibur thinks is a misspelled word, hit the Ignore
button. Excalibur will ignore any subsequent occurrence of this word also. You can
change this behavior in the Options menu.
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7.4 Adding Words to a Dictionary

Excalibur flags any word that is not in an active dictionary. To add the flagged word to
an active dictionary, hit the Add... button. You can add the word to any active dictio-
nary that is modifiable. The Standard Dictionary is read only.

Use the checkbox to always select the same dictionary for the word you are spell
checking. When you do this, Excalibur will stop presenting the Add dialog every time
you add a word. If you have checked this box, you can force Excalibur to bring up
the dialog by holding the shift key down while you click on Add. This allows you to
deselect the checkbox or select a new set of dictionaries to automatically select from
then on.

After adding a word to a dictionary, you will still have to take an action on the current
word. It will often be the case that you would like to simply ignore the word now that
you have entered it into a dictionary. You can use the Options menu to make this the
default action.

Note: In order for the Add... button to be operational, you must have at least one
modifiable dictionary that is active. A dictionary is not modifiable if its name appears
in italics in the Dictionary menu. A dictionary is active if it is checked.

7.5 Quitting Excalibur

To quit Excalibur, select Quit from the File menu. If you forgot to save your correc-
tions, Excalibur will warn you. Excalibur will also warn you if you forgot to save any
changes to your dictionaries or if you have not saved any changes to your definitions.

7.6 Spell Checking Options

Ignore All CAPS instructs Excalibur to ignore words that do not contain any lower
case letters.

If you hit the Ignore button and the Ignore Throughout option is checked, Excal-
ibur will ignore any subsequent occurrences of the word.

If you change a word and the Replace Throughout option is checked, Excalibur
will replace all subsequent occurrences of the word also. Note that you have to finish
spell checking the document for this to happen. If you stop spell checking a document
before reaching the end, Excalibur may not replace all occurrences of the word even
though you have checked this option.

If you select the Auto Suggest option, Excalibur will automatically make sugges-
tions when it shows you a misspelled word.

7.7 Dialog Behavior Options

If you attempt to replace a misspelled word with a word that is not in any active dictio-
nary, you may have Excalibur take one of three actions.

1. Quietly let you replace the word.

2. Beep, then let you replace the word.
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3. Put up a dialog that warns you that the word is not in any active dictionary, then
let you replace the word. This is the default.

These last two actions are useful because they give you the opportunity to enter the
replacement word into a dictionary before continuing.

7.7.1 Press Ignore Button Automatically .. .

If you have just added a word to the dictionary, you will often want to press Ignore to
indicate that you are finished with the word. This option causes this to happen automat-
ically. You will immediately advance to the next misspelled word when this option is
checked. If you find that you often want to enter several words at once to the dictio-
nary (for example, the same word with several different endings), then you may wish
to uncheck this option.

7.7.2 Press Change Button Automatically .. .

If you have just added a replacement word to the dictionary, you will often want to press
Change to make the change and advance you to the next word. This option causes this
to happen automatically. If you find that you often want to enter several words at once
to the dictionary (for example, the same word with several different endings), then you
may wish to uncheck this option.

7.7.3 Save Dictionaries without prompting

If you have made changes to user defined dictionaries and you quit Excalibur, it will
automatically save your dictionaries for you if this option is set. If this option is not set,
Excalibur will warn you before quitting.

7.8 Word Boundary Options

The Use German babel conventions option tells Excalibur that you are using " when
typing an umlaut. For example, this tells Excalibur that "u is the same as \"u. When
you turn on this option Excalibur will also know about the German double quotes "’
and "‘, the French double quotes "< and ">, the hyphens "-, "", and "=, and the ß
(es-zet) \3, "s and "z. This option is not available if you do not have LATEX command
parsing turned on.

The Single quote marks end of word option tells Excalibur that a single quote
will never be part of a word. This is probably not useful for English speaking users
since this causes Excalibur to no longer recognize contractions. It may be useful in
French though. If the word “application” is in the dictionary, then Excalibur won’t
flag “l’application.” Even if this option is checked, Excalibur will still recognize the
\’ accent.

The Regard ’s as end of word option tells Excalibur to stop parsing a word when
it reaches ’s. Thus, if the word “Knuth” is in your dictionary, Excalibur won’t flag
“Knuth’s”. This option is probably most useful to English speaking users. This option
is not available if Single quote marks end of word is checked.
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7.9 Start-Up Actions

The Present an Open File Dialog option tells Excalibur to present a standard open file
dialog when the program starts.

The Open the Clipboard option tells Excalibur to open the clipboard when the
program starts. This will only happen if the clipboard contains text. This option also
causes Excalibur to automatically open the clipboard whenever you bring Excalibur
into the foreground. If you keep Excalibur running so that you can periodically spell
check the contents of the clipboard, this will make this operation faster.

The Open Clipboard and Go option is similar to the Open the Clipboard option.
It tells Excalibur to open the clipboard when the program starts or when you bring Ex-
calibur into the foreground. It starts spell checking immediately without the need to
press the Start button. When you close the window, Excalibur saves the results back
onto the clipboard. To override this option, hold down the shift key when you bring
Excalibur into the foreground. It will still open the clipboard, but it won’t automati-
cally start spell checking. If you hold down the shift key when you close the window,
Excalibur will not automatically write the document back onto the clipboard. Instead,
it will warn you if the document is dirty.

The Do Nothing option causes Excalibur to do neither of the above actions when
you start the program.

7.10 LATEX Options

If Do LATEX Command Parsing is checked, Excalibur assumes that the file you are
processing contains TEX/LATEX commands.

Ignore \tt Text instructs Excalibur to not spell check words that are in the type-
writer font.

Warn on Parsing Errors causes Excalibur to warn you if it thinks it found a LATEX
syntax error.

Use TEX Style Accents instructs Excalibur to use escape sequences when making
corrections that use accents. For example, when making a correction it will represent
the word naı̈ve as na\"{\i}ve. If you type text into the Change To: box using the
extended character set, Excalibur will translate the text so that it uses TEX style accents
when making the correction. This is useful if you don’t remember the TEX sequence for
a particular accent.

This option also affects how Excalibur copies text from the suggestion list to the
Change To: box. Words always appear in the suggestion box using the extended char-
acter set. However, Excalibur will copy them to the Change To: box with TEX style
accents so you can see how they will appear in the document.

Use Extended Character Set instructs Excalibur to use Apple’s extended charac-
ter set when making corrections that use accents. For example, it will use naı̈ve instead
ofna\"{\i}ve. Even if you type text in the Change To: box using escape sequences,
Excalibur will translate the text into the extended character set when making the correc-
tion. If no translation is available (for example, the character č doesn’t exist in Apple’s
character set) Excalibur will insert the word unchanged.
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7.11 Saving Preferences

Save your current preferences by selecting Preferences.. . in the Options menu. You
can ask Excalibur to remember the dictionaries and definitions that you are currently
using. You can also ask it to remember your spell-checking, dialog behavior, and word
boundary options.

8 Known Problems

When you correct a word, Excalibur does not update the screen to reflect the correction.
However, the change does take place.

9 Large Documents and Dictionaries

The size of a document or dictionary is limited only by the amount of memory on your
machine. If you are using System 7 or higher, Excalibur will use any free memory
on your machine to load large documents or dictionaries, or to perform dictionary con-
versions. Quitting other applications will make more memory available to Excalibur.
Under System 6 you may need to increase Excalibur’s memory partition.

Under System 6, here is what to do if Excalibur complains about not having enough
memory to open a document, load a dictionary, or to perform a dictionary conversion.
Quit Excalibur and highlight its icon on the desktop. Select Get Info from the File
menu. Make the current size of Excalibur larger.

To set the optimal partition size under all versions of the system software, use the
following formula. Compute the total size of all your dictionaries and add 500K. For
example, if the dictionaries you are using have a total size of 1,000,000K, set Excal-
ibur’s memory partition to 1,500,000K.

10 Frequently Asked Questions

1. If there is a TEX and LATEX way of doing the same thing, which should I choose?

If there is a TEX and LATEX way of doing things, Excalibur usually handles the
LATEX method better. For example, use

\input{file}

instead of

\input file

Use the \symbol{} command instead of \char. For example, you should use

\symbol{’134}
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instead of

\char’134

to produce a backslash.

Use the \setlength{}{} command change the length of something. For ex-
ample, you should use

\setlength{\textwidth}{6.5in}

instead of

\textwidth=6.5in

Use \newcommand or \renewcommand instead of \def to define a com-
mand.

2. I’ve redefined a LATEX command to have a different number of arguments than
usual and now Excalibur is confused. What should I do?

Be careful when using \renewcommand. Excalibur doesn’t look at the new
definition of a command. If you define it to have a different number of arguments
than the original command, Excalibur will get confused. Tell Excalibur about
the new form of the command by using the Definitions menu. See section 6.3
on page 5.

3. Excalibur seems to be skipping large portions of my file. How do I fix this?

Excalibur knows a fair amount about TEX/LATEX syntax. If it looks like it’s skip-
ping large portions of a file, it’s probably because of an unmatched brace or some
other syntax error. It’s best to run it on a syntactically correct file. It will warn
you if it thinks it found a syntax error.

4. How do I get Excalibur to recognize accents in a tabbing environment?

The commands \=, \’, and \‘ usually produce accents. However, they are re-
defined in a tabbing environment. To make sure that Excalibur interprets them
properly in a tabbing environment, precede (unless at the beginning of a line) and
follow them by a space. Excalibur knows about the special \a accent in the tab-
bing environment.

5. Excalibur is having trouble finding the end of an environment. How do I fix this?

For any environment that Excalibur ignores, there should be no spaces between
the \end and the left curly brace. For example, \end {verbatim} will con-
fuse Excalibur.

6. I’m using \equation . . .\endequation and Excalibur is not ignoring the
equations contained within. What’s wrong?

If you use \equation . . .\endequation to delimit the bounds of an equa-
tion, Excalibur won’t ignore it. You should use
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\begin{equation}
\end{equation}

instead.

7. Are there any limitations on Excalibur’s parsing of TEX documents?

A word may not begin with a left curly brace, but it may contain embedded curly
braces. For example, Excalibur will recognize the word “naı̈ve” when it is writ-
ten as na\"{\i}ve, na\"\i{}ve, or na\"\i ve but not {na\"\i}ve,
even though this last form is syntactically correct. Of course you will need to put
these in your dictionary if you would like Excalibur not to flag them as spelling
errors. Note that a space may be part of a word.

8. Excalibur is having trouble suggesting accented words. Why?

If you are using version 2.3 or later, Excalibur will do a much better job of sug-
gesting words if your dictionary has words stored using Apple’s extended char-
acter set.

9. I’ve defined my own shorthand verbatim environment and Excalibur doesn’t like
it. How do I instruct Excalibur about my verbatim environment?

A declaration such as \def|{\verb|} will allow you to write |\rule| as a
shorthand for \verb|\rule|. However, this will completely confuse Excal-
ibur. It will start looking for the arguments to \rule and report a syntax error.
Use \MakeShortVerb{\|} instead and Excalibur will do the right thing. It
knows about \DeleteShortVerb{\|} too.

If you have an old LATEX 2.09 file that creates a shorthand verbatim environment
in the manner just described, you can trick Excalibur into recognizing it by in-
cluding the following lines in your file.

\iffalse
\MakeShortVerb{\|}
\fi

Excalibur doesn’t process the \iffalse command and so it will process the
\MakeShortVerb command.

10. I’ve checked the option that instructs Excalibur to ignore \tt text, but it doesn’t
ignore \texttt text. How do I get it to ignore this too?

LATEX 2ε defines the command \texttt for specifying text in the typewriter
font. The option to ignore \tt text does not have any effect on this command.
If you want Excalibur to ignore the argument of \texttt, use the Edit Com-
mands dialog.

11. I want to nest math environments, but Excalibur gets confused by this. Is there
a way around this?

If you nest math environments which are delimited by $’s, Excalibur will get
confused. You should use \(. . .\) instead. For example, instead of
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$\Lambda = n \in I \mbox{for all $n \ge 0$}$

use

\(\Lambda = n \in I \mbox{for all \(n \ge 0\)}\)

12. I’m using a package the redefines the \cite command to have more than one
optional argument. Now Excalibur refuses to spell check my document. How
do I tell Excalibur that \cite may have more than one optional argument?

Use the Edit Commands dialog to tell Excalibur that the \cite command has
one argument. This may not seem different than the usual definition, but there’s
a subtle difference. Excalibur will ignore all optional arguments for commands
defined using the Edit Commands dialog. If you use this package frequently,
save your preferences and Excalibur will remember this setting every time you
use it.

13. How do I tell Excalibur not to spell check an e-mail or HTML address?

If you are usingAMSLATEX use the \email command. Excalibur does not spell
check the argument to this command.

You could could also use\texttt to specify the e-mail address in the typewriter
font. Then tell Excalibur to ignore the argument of \texttt by using the Edit
Commands dialog.

You can achieve the same effect by using the \verb command. Since Excalibur
always ignores the argument of this command, there’s nothing else to do. This
has the added advantage of causing LATEX to ignore % and _ (underscore) which
occur in some e-mail addresses.

You could define your own \email command and tell Excalibur to ignore its
argument.

Since HTML addresses tend to be long, it’s probably best to put them in a verba-
tim environment.

14. I have set the options the way I want them, but Excalibur doesn’t remember them
the next time I launch it. Why?

You must select Preferences from the Options menu and save your preferences
otherwise they remain in effect for just the current session.

11 Excalibur Genealogy

Excalibur has its roots in a software engineering course at Bucknell University in the
spring semester of 1990. Rob Gottshall and Rick Zaccone produced the current version
using the original application as a base.
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11.1 Version 2.5.1, November 26, 1997

• Bugs fixed:

– Excalibur no longer displays a dialog when it receives an Apple Event it
doesn’t understand.

– Excalibur now handles DOS and Unix files correctly.

– Fixed a rare bug that sometimes caused saves to fail under System 6 while
running over an AppleTalk network.

11.2 Version 2.5, July 3, 1997

• New Features:

– Excalibur supports the Word Services batch check, check word and guess
word events. I have tested it with MT-NewsWatcher, Eudora Pro, Commu-
nicate 2.0 (due in late summer), Nisus Writer, and ClarisWorks. Excalibur
is a plain text spell checker, so it works best in Nisus Writer and ClarisWorks
if you check a segment of text that uses a single font and size.

– The Excalibur manual and the Excalibur home page are now available
through the help menu if you have Internet Config installed.

– If you have Internet Config installed, Excalibur will use it to determine the
file type when you select Save As.

• Bugs Fixed:

– Fixed a bug that caused buttons to appear as check boxes under System 8.

– Fixed another bug related to converting very large dictionaries to text files
on 68K machines.

11.3 Version 2.4, June 1, 1997

• New Features:

– Improved suggestions.

– Use a AGA compliant popup menu in the edit commands dialog if possible.

– Changed the Edit Commands dialog so that there is more room for the
command name.

– The “Use german.sty conventions” option is now called “Use German babel
conventions”.

– Excalibur knows how to translate "s and "z when German babel conven-
tions are turned on.

– Added a check box to the open file dialog that enables you to view only
*.tex and *.ltx files. If you save preferences, Excalibur will remem-
ber the contents of this check box.
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– Excalibur knows about the Catalan geminated-l digraph. In LATEX it recog-
nizes \l.l and \L.L. Using the Macintosh character set, type l·l or L·L
where · is a centered dot.

– Modal dialogs are now moveable.

– Better handling of eastern European and extended Roman scripts.

• Bugs Fixed:

– Fixed a crashing bug when converting a dictionary to text. It only occurred
when converting very large dictionaries.

– Fixed an minor update problem in the spell check window.

– Better error detection when opening files. It knows about AppleShare deny
modes and it checks for locked volume.

– Fixed a minor update problem in open and save file dialogs.

11.4 Version 2.3.1, November 17, 1996

• New features:

– Added some conformance to Apple’s Grayscale Appearance.

– If you ask Excalibur to remember which dictionaries are currently active,
it checks to see if the file or an alias to it is in its folder. If not, it will remind
you that it won’t be able to find the dictionary the next time you launch the
program.

• Bugs fixed:

– Suggestions are much faster.

– Fixed a bug that caused Excalibur to squeeze blanks out of words in the
Change To: box.

– Fix a problem with Excalibur not being able to recognize characters in the
extended character set on systems that use a non Roman script.

11.5 Version 2.3, September 7, 1996

• New features:

– Excalibur is much better at making suggestions.

– Excalibur gives you the option of making corrections using TEX style
accents or with Apple’s extended character set. See LATEX Options on
page 10 for more information.
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– When Excalibur adds a word to a dictionary, it will do so using Apple’s
extended character set if possible. This helps to make the new suggestion
algorithm work better.

If you have been saving words with TEX style accents, you should convert
your dictionary. Using Excalibur 2.3, convert your current dictionary to a
plain text file. Then, convert it back into a dictionary. Don’t forget to set
your spell checking options before doing this second conversion. You do
not need to make any changes to the Standard Dictionary.

• Bug fixes:

– Improved error checking and error recovery when opening and saving files
that are in use by other applications.

11.6 Version 2.2.2, April 18, 1996

• New features:

– Added processing for

\DeclareMathOperator
\font
\textcircled

– Excalibur now knows about theAMS-LATEX variants of the following com-
mands:

\newcommand
\newenvironment
\newtheorem
\parbox
\providecommand
\renewcommand
\renewenvironment

– Buttons are now indented when you press them so they look like they’re
pressed.

• Bugs Fixed:

– Fixed a bug that caused Excalibur to skip two characters following a math
environment delimited by \(. . .\).

– Fixed a hard to reproduce bug that caused Excalibur to crash on some ma-
chines that don’t have color.

– Corrected the processing of \email.

– Shift key didn’t bring up Add Words dialog if there was only one modifiable
dictionary.
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11.7 Version 2.2.1, March 13, 1996

• New features:

– Added processing for \MakeShortVerb and \DeleteShortVerb.

– Added a start-up option that causes Excalibur to start spell checking when-
ever it opens the clipboard. When this option is set, closing the window
saves the results back to the clipboard. Holding down the shift key over-
rides the new behavior in both cases.

– Got rid of the Save To Clipboard menu item. Now the text of the Save item
changes to Save Clipboard when the document is a clipboard.

– Allow the nesting of \(. . .\) pairs.

– Better memory management. You don’t have to increase the application
size to use a large dictionary.

• Bugs fixed:

– Fixed a bug that caused the Add button to not update when the user creates
a new dictionary.

– Fixed the About Box animation.

– Fixed a bug that caused new commands not to get inserted into the list of
commands properly.

– Improved reporting for LATEX syntax errors. Most of the parsing code is new.

– Better recovery when a dictionary fails to load.

– Disable Convert menu if the dictionary list is full.

– Fixed two minor bugs that caused Excalibur to report a syntax error when
there was no error.

11.8 Version 2.2, January 25, 1996

• Got rid of some of Excalibur’s alerts. The program operation is much smoother.
Excalibur displays the current state of the program rather than announce it with
alerts.

• Excalibur no longer beeps when it can’t find a suggestion. Instead, it puts a mes-
sage into the suggestion box. It’s much less annoying now, and it’s fast enough
on the power Mac that you may want to leave the Auto Suggest option checked.

• Excalibur will now open aliases to dictionaries. For example, suppose there’s a
dictionary on a server that you would like to use every time you launch Excal-
ibur. Put an alias to that dictionary in the Excalibur folder and it will open it
when you launch the program.

• If a document is already open, you can replace it with another as long as a spell
check operation is not in progress.
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• Excalibur now has a Spanish dictionary. See Other Dictionaries (section 14 on
page 27) for information on where to find it and other dictionaries.

• Excalibur remembers the folder of the last file you opened.

• Excalibur continues to look for dictionaries after finding an old style dictionary.

• Fixed a dictionary conversion bug that caused Excalibur to think it was out of
memory when it really wasn’t.

• Revised Excalibur’s balloon help.

• Dialogs draw faster on a PowerPC.

• Numbers now have a thousands separator.

• Fixed a problem with hitting the Restart button when the document is a clipboard
snapshot.

• Updated the BBEdit icon so that it is in step with the BBEdit 3.5 icon.

• Fixed a bug that caused Excalibur to not properly remember your preferences
for commands.

• Fixed a menu update problem.

• Made e-mail address in About Box easier to read.

• There are many other minor changes.

11.9 Version 2.1, March 28, 1995

• Excalibur now has a new look!

• There are better error message when Excalibur detects a syntax error.

• There are better error messages when doing conversions.

• When doing a dictionary to text conversion you can select the text file type from
a pop-up menu.

• Double clicking on a misspelled word copies it into the Change To: box.

• If you have just one modifiable dictionary, Excalibur doesn’t ask you which dic-
tionary to add a word.

• Excalibur requires System 6.0.5 or greater.

• Excalibur now observes the Ignore all CAPS option when converting from text
to dictionary.

• Fixed a bug that caused Excalibur to sometimes suggest the same word more
than once.
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• Added support for the german.sty sequences "| (separate ligatures) and "˜
(unbreakable hyphen).

• The About box animation works at the same rate regardless of the CPU speed.

• There are various other adjustments and bug fixes.

11.10 Version 2.0.1, January 12, 1995

• A word is considered to be all caps if it doesn’t contain any lower case letters.
Thus, “FRED’S” is now all caps as is “68K”. Previously, all characters had to be
upper case letters.

• Excalibur sometimes thought that definitions were dirty when they were not.
This no longer happens.

• Fixed some minor problems with dictionary names in the Dictionary menu.

• Better handling of dictionaries and memory. Unchecking a dictionary purges it
from memory.

• The Edit Commands and Edit Environments dialogs are now in color.

• It’s now legal to create a command with zero arguments. This is useful if you
want to override a built-in command to have zero arguments.

• Fixed a problem that caused Excalibur to sometimes not find dictionaries at start-
up.

• Various other minor fixes.

11.11 Version 2.0, July 6, 1994

• Excalibur now runs in native mode on a PowerPC.

• Excalibur uses a new dictionary format that greatly speeds up operations in lan-
guages other than English.

You will need to convert any dictionaries you created with a previous version of
Excalibur to this new format. Here’s the procedure for doing that. (The dictio-
nary we are distributing with Excalibur 2.0 is a new version of the Standard Dic-
tionary.)

Use your current version of Excalibur (1.x) convert your dictionary to a text file.
Then use Excalibur 2.0 to convert that text file back into a dictionary. Don’t for-
get to pay attention to your option settings when creating a new dictionary. For
example, if you set the option to treat ’s as the end of a word, no words with ’s
will appear in your dictionary.

Excalibur 2.0 is smart enough to display an error message if you try to open an
old style dictionary. Old versions of Excalibur may crash if you try to open a
new style dictionary.
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• Excalibur uses temporary memory to open large files and when doing text to
dictionary and dictionary to text conversions. This means that if there is enough
memory on your machine, you won’t have to increase Excalibur’s partition size
to open a large file or to do a conversion.

• Excalibur has a vastly improved memory management scheme. It should always
recover gracefully from a low memory situation.

• Text to dictionary conversions use much less memory. Fixed a few bugs associ-
ated with conversions.

• Hitting the Enter key selects the default item in the control dialog.

• Excalibur knows about the SLITEX and seminar.sty versions of the slide en-
vironment.

• Excalibur’s interaction with Alpha is smoother. If you select Spellcheck Win-
dow in Alpha and Excalibur already has a window open, it will close it and spell
check the new document. It does this more smoothly now.

• Excalibur uses intelligent suggestions for the new file names when doing con-
versions. You can customize the strings that Excalibur uses for extensions by
changing resource STR# 306.

• The behavior of the Add Word. . .menu item has changed slightly. Now it adds
a word only if it doesn’t appear in any other active dictionary. If you would like
to add a word to a dictionary even if it appears in another dictionary, hold down
the option key when you click on the Add button.

• Various smaller changes.

11.12 Version 1.5.1, April 10, 1994

• Fixed some clipboard problems that surfaced when running System 6.

• Saving now works properly on EasyServer and CAP (Columbia AppleTalk Pack-
age) volumes. It now works under A/UX 3.0 too. (Thanks to Stuart Castergine
for helping me fix this.)

• Excalibur knows about new LATEX 2ε commands.

• Put up an alert if the preferences file is out of date.

• The updating of statistics while spell checking is now flicker free.

• The buttons in the control dialog are handled a bit more intelligently. If the text in
the Change To: box and the flagged word are the same, then the Change button
is inactive. If there is no text in the Change To: box, then the Ignore button is
the default.

• A ‘@’ can now be part of a user defined command or environment name.
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• Fine tuned memory management somewhat.

• Fixed a rare bug that would cause Excalibur to be unable to find dictionaries.

11.13 Version 1.5, January 14, 1994

• Added options that let the user choose how Excalibur should behave when you
launch it. You may choose to present an “open file” dialog, open the clipboard if
it has text, or do nothing. When the clipboard option is checked, Excalibur will
also open the clipboard when it receives a resume event (if it contains text).

• Adjusted a few of the dialogs so that they all appear and behave consistently. Hit-
ting Return or Enter is the same as clicking the default button. Command period
is the same as cancel.

• Made some changes so that Excalibur’s interactions with Alpha are smoother.

• Fixed the Edit Commands dialog so that it is a bit more intuitive.

• Fixed the Edit Environments dialog so that you no longer enter the number of
arguments. Excalibur never used these values anyway.

• You can now drag Excalibur’s windows to another monitor.

• Fixed a few minor bugs.

11.14 Version 1.4.2, August 11, 1993

Fixed a bug that caused all the buttons in the control dialog to be inactive during the
correction phase. This happened on 68000 based machines.

11.15 Version 1.4.1, August 4, 1993

• Repaired several minor bugs including better error handling under low memory
conditions.

• You can now convert larger text files into dictionaries. If you create a really large
dictionary you may not be able to read it with an older version of Excalibur.

• Excalibur knows about the conventions in german.sty. If you turn on the
option to treat " as if it were \", Excalibur will also know about the hyphens
and quotes defined in german.sty.

11.16 Version 1.4, July 11, 1993

• You may now spell check the contents of the clipboard. You may save the results
back to the clipboard too.

• You may now teach Excalibur about new commands and environments that you
have defined.
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• Fixed some update problems that occurred when balloon help was on.

• Fixed a problem with the Save As... command.

• Fixed a problem that caused a flagged word to not appear on the screen. This
occurred very rarely.

• Excalibur now handles the \cite command properly.

• Fixed an obscure bug in the Add Words... dialog.

• Added an option that tells Excalibur to treat " as if it were \". If you type ü
as "u instead of \"u, Excalibur will be happy. Many German speaking users
requested this change.

• There is an option that will cause Excalibur to always have a single quote mark
the end of a word. This is not good for English speaking users since Excalibur
will not recognize contractions when this is on. However, many French speaking
users requested this.

• When the Use selection from now on box is checked in the Add... dialog, the
ellipses no longer appear in the Add button. This gives you a visual indication
that this box is checked.

• If you have an older version of Excalibur, you will need to rebuild your desktop
in order to see the new icon for definition files.

11.17 Version 1.3.3, May 1, 1993

• Version 1.3.3 has a better algorithm for suggesting words with accents.

• Added processing for \epsfbox command.

• Most text that appears in dialog boxes is now in string resources. This should
make it easier to localize Excalibur.

• Some Excalibur users have been kind enough to contribute additional dictionar-
ies. There are British, Dutch, French, German, Italian and Spanish dictionaries
in the directory

/pub/mac/Excalibur-dictionaries

on

ftp.eg.bucknell.edu

We will gladly accept any other non-copyrighted dictionaries that users are will-
ing to contribute.

• We also eliminated the help facility in this version. The balloon help makes it
unnecessary.
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11.18 Version 1.3.2, April 10, 1993

• Excalibur now has balloon help.

• You may now optionally ignore ’s at the end of words.

• There is an option to automatically suggest a correction to a misspelled word.

• The error correction phase of Excalibur is now faster. Under certain rare circum-
stances, the error correction phase would slow down. This no longer happens.

• In preparation for some future additions to Excalibur, we have rewritten much
of the display code. A few things look different, but there are a lot of changes
under the hood.

• Fixed some problems with the Standard Dictionary.

• Numerous minor fixes and adjustments.

11.19 Version 1.3.1, February 7, 1993

This version corrects a bug in the LATEX parsing, and it correct several minor display
problems.

11.20 Version 1.3, January 10, 1993

• Excalibur handles disk insert events. If you insert an uninitialized disk while
Excalibur is running, it will ask you if you want to initialize it.

• Excalibur now recognizes the \lefteqn command.

• Excalibur positions alerts and dialogs according to the Human Interface Guide-
lines.

• Excalibur saves both the resource and data forks of a file. Previously, it didn’t
save the resource fork under System 7.

• Excalibur looks at the “Do LaTeX Parsing” option when doing text to dictionary
conversions. If this option is checked, Excalibur will recognize TEX accents and
ligatures in words.

• Text to Dictionary conversions are faster. They also require more memory.

• Excalibur correctly updates the document window.

• Drag and Drop should work better.

• Numerous bug fixes.
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11.21 Version 1.2

We produced version 1.2 in September 1992. Here are the features and bug fixes we
added.

• Fixed problem with recognizing the tabular* environment.

• Excalibur is now System 7 friendly. It handles the required Apple events. (It
handles the Print event, although it doesn’t do anything.) As a result, it handles
drag and drop operations properly. You may drag just one file at a time.

• Excalibur now uses a “safe save” technique for saving files if you are running
System 7. That is, it saves the file into a temporary file. Once the save has suc-
cessfully completed, Excalibur moves the file onto the original. This may make
a difference if you are saving onto a floppy disk. Make sure there is enough room
for two copies of the file.

• Excalibur now requires System 6.0.4 or higher.

• Excalibur recognizes the Apple extended character set.

• Fixed a display bug in the “About the Authors” dialog.

• Excalibur now recognizes AMS-LATEX environments. In particular, it knows
about the environments
align gather*
align* multline
alignat multline*
alignat* xalignat
comment xalignat*
equation* xxalignat
gather xxalignat*

• It knows the AMS-LATEX commands

accentedsymbol numberwithin
addtoversion operatorname
email operatornamewithlimits
eqref series
family shape
newmathalphabet theoremstyle

• If Excalibur gets an error while trying to save a file, it tries to print a meaningful
error message. If it gets an error for which it doesn’t have a message, it prints the
error number.

• Added Preferences File that saves spell-checking and dialog options as well as
the names of active dictionaries.

• Changed Help dialog button from OK to Done.
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• Added Text to Dictionary and Dictionary to text file conversions. Text files can be
saved as MS Word, Alpha, or generic text files. Alpha contains some nice support
for LATEX. It’s well worth the shareware fee.

11.22 Version 1.1

Version 1.1 was produced in February 1992. We have rewritten substantial portions of
version 1.0.

Some new features include:

• User defined dictionaries now work.

• Many improvements to the user interface.

• LATEX/TEX command recognizer completely rewritten. LATEX command recogni-
tion is now excellent. Plain TEX command recognition is good. The syntax of
plain TEX is difficult to parse. We are not sure how much the plain TEX recogni-
tion will improve in the future, but please send us information about any problems
you have.

• Excalibur knows about accented characters and ligatures.

• Excalibur will optionally ignore text in the \tt font.

• Excalibur will now warn you if it thinks it found a LATEX syntax error in a file.

• Excalibur is considerably faster than version 1.0.

11.23 Version 1.0

Version 1.0 was produced in May 1990.

12 Plans for the Future

We will fix any bugs that people find. Please use the information in Suggestions and
Bug Reports (section 13 on page 26) to send us bug reports.

We welcome suggestions on how to improve Excalibur.

13 Suggestions and Bug Reports

We are very interested in maintaining and improving this program. If you have a bug
report and your bug is not easy to reproduce, try to send us a small file that readily re-
produces the problem. Be sure to mention which version of Excalibur you are using.

Send comments, suggestions, and bug reports to:
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Rick Zaccone
Computer Science Department
Bucknell University
Lewisburg, PA 17837
U.S.A

Phone: 717-524-1393

Electronic mail: zaccone@bucknell.edu

14 Other Dictionaries

You may ftp the latest version of Excalibur from

ftp://ftp.eg.bucknell.edu/pub/mac/

You will also find dictionaries for British, Catalan, Dutch, French, German, Italian, Nor-
wegian and Spanish in the dictionary directory

ftp://ftp.eg.bucknell.edu/pub/mac/Excalibur-dictionaries/
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16 Excalibur Legend

Excalibur is King Arthur’s great sword. It sometimes gives off light and occasionally
is wielded by Gawain. Excalibur is given to Arthur, and finally taken from him, by a
hand in the lake. Merlin, who brings Arthur to the Lady of the Lake to receive Excal-
ibur, informs the King that the scabbard is worth far more than the sword itself, for the
former will protect its bearer from injury. Despite this fact, it is the sword rather than
its scabbard that has captured the imagination of later writers and readers.

17 Legal Fine Print

Excalibur is free. However it is not public domain and we retain the copyright. You
may not charge to redistribute this program except for normal download fees. You may
not distribute Excalibur with a commercial package without written permission from
the authors.
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Textures is a commercial version of TEX for the Macintosh produced by Blue Sky
Research.

OzTEX is a shareware version of TEX for the Macintosh produced by Andrew Trevor-
row.
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